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TEMPLATE TIPS
A reference guide for use of the 
University of Georgia DAR proposal 
templates. If you have questions about 
the templates that this document does 
not answer, contact proposal writer 
Clarke Schwabe (ccschwabe@uga.edu, 
706-542-8386).
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COMMON TIPS
Preferred fonts and colors

Adding pages to your document

Our templates are designed specifically with UGA brand colors and fonts in mind, so please 
use only those fonts and colors designated as theme fonts and colors in the templates. 

• Our fonts are Georgia or Arial Narrow Bold. Generally, Georgia is good for body text and 
Arial Narrow Bold works well for titles and headers. 

• Your document’s primary colors should be the designated theme colors in the template. 
UGA brand colors found at brand.uga.edu/color may be used very sparingly.

Once you’ve opened a template file and you’re ready to begin constructing your document, 
you can add pages by clicking the small down-arrow next to the New Slide button in Pow-
erPoint. This will present you with all the page options. 

Some of these options have two versions, an Example sheet and a Template sheet.

The Example sheet cannot be edited outside of Slide Master view and exists to show you 
what a Template sheet can do. The Template sheet is what you should use as a page for your 
document.
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Accessing Slide Master

Saving your document

Slide Master is where you can make changes across your entire document. In Slide Master 
view, you’re able to edit every pre-set page the templates allow you to place, and those ed-
its are implemented across every page of that type in your document. For this reason, it’s 
important to be very careful about the changes you make in Slide Master.

To access Slide Master, click the View tab at the top of your PowerPoint window, then se-
lect the Slide Master button.

What you plan to do with your finished document determines how you should save the 
completed file. If you are planning on printing the document or presenting it as a digital 
document, click File, then Export. On the resulting window, make sure the selected File 
Format is PDF, then save your file. If you are planning to use the file as a PowerPoint pre-
sentation, you can simply save as normal: click File, then Save.

One change you will want to make for every document you produce using these templates 
is found in Slide Master: the header. If you want to include a header with the document 
recipient’s name(s) on it, select the top page in the list on the left side of the window, 
then click the text on the page that reads “RECIPIENT NAME HERE” and change it to your 
recipient’s name(s). If you do not wish to have a header in your document, select this text 
and delete it.

As a side note to this, two other things you should always check when creating documents with 
these templates: the cover and the table of contents. If you are using either of these pages, note 
that you must manually adjust the recipient name on the cover page and the page numbers on 
the table of contents.

When in Slide Master, do not change any settings under the Themes, Colors, Fonts or 
Background Styles buttons. Any change to these settings affects all elements of the docu-
ment and removes UGA branding.

Finally, to return to the normal view of your document, select the Slide Master tab and 
click Close Master.
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Transferring large files
Sometimes the files created by using these templates will be too large to send via email. In 
the event that you need to send a large file electronically and email is not an option, we 
recommend using wetransfer.com to send these files.

Using WeTransfer is very easy. When you navigate to the page, click the Add Your Files 
button and select the files you want to transfer. Next, click the ellipsis to the left of the 
Transfer button and make sure that the link option is selected, not email. Click Transfer, 
and after your file uploads, the site will give you a link you can send to your intended recip-
ient(s) that will allow them to download your file.

Please note that links created via WeTransfer expire one week after they are created, so make sure 
to upload your file again and create a new link if it’s been a week or more since you last uploaded 
it.

Alternatively, you can reduce the size of your file if you have Adobe Acrobat. Open your 
finished PDF in Acrobat, then select File, Save As. In the window that opens, near the top, 
check the box that reads “Reduce File Size.” Then select Choose a Different Folder, select 
where you want to save the file and the file name, then click Save. The process will take a 
moment, but when it’s finished, you should have a dramatically smaller file.

Body text size
When dealing with body text, we recommend using a font size no smaller than 11 pt and no 
larger than 14 pt. 

Title/header size
When sizing the text in your titles and headers, watch out for the number of lines your 
title/header creates. Use your best judgment on this—the idea is to balance emphasis with 
readability. We believe that limiting the title/header to 1 line is best, 2 lines are good, 3 are 
acceptable, but more than that begins to be distractingly large. 

Text frame resizing
Text frames can be set to either automatically resize the text within them or to resize 
themselves based on that text. This can be useful if you have a set amount of space you’d 
like to devote to text, regardless of text length, or if you need a text frame to adjust to the 
length of your text, in order to use the text frame to align other objects on your page.

TEXT
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Text frame resizing, continued
By default, all text boxes (except on the cover page) in our templates do not have either op-
tion selected. If you would like to enable these settings, though, you can do so by access-
ing Text Options.

To access a text frame’s Text Options, right-click anywhere in the text frame and select 
Format Text Effects. This will open a panel on the right side of your window. Here, select 
the Textbox button, which looks like a small white block of text.

This will present you with a number of options, including Do not Autofit, Shrink text on 
overflow, or Resize shape to fit text. These options will apply only to the text frame you 
right-clicked.

Do not Autofit: Text you enter will appear at the size you designate, regardless of the size of 
the text frame.

Shrink text on overflow: Text you enter will appear at the size you designate until you enter 
more text than will fit in the space of the frame. At this point, PowerPoint will automatical-
ly resize all text in the frame to fit.

Resize shape to fit text: Text you enter will appear at the size you designate. Once you enter 
more text that the frame can fit, PowerPoint will automatically resize the frame to fit.
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Using your own photos
Sometimes the photo you need is one that didn’t come from the Proposal Toolkit, and 
you’re not sure how it will appear on paper—no one wants a highly pixelated image in their 
proposal. A good rule of thumb is to use photos which have a smallest dimension of 2550 
(1700 minimum).

If your image doesn’t meet the suggested 
minimums and you still want to use it, it’s 
best to print a test sheet using that image to 
see how it appears. Insert your image in the 
template, size and crop it the way you want 
it to appear, then print this page to see if the 
resulting image is too pixelated.

• On Mac, in a Finder window, right-click 
on your image and select Get Info. In the 
window that opens, under the More Info 
tab (click the title to open that tab if it 
isn’t already open), you will find the im-
age’s dimensions.

PHOTO/GRAPHIC

To check your image’s dimensions:
• On Windows, click on your photo in an 

Explorer window. The dimensions should 
appear at the bottom of the window.
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Graphic frames
In order to size your images on the page correctly and display only the part of the image 
you wish to show, you’ll need to understand how to work with graphic frames.

To resize an image on your page, click on the image, and then click and drag one of the 
8 handles (small white boxes around the image) in any direction. To maintain the aspect 
ratio of your image (in other words, to make it larger or smaller without making the image 
look “stretched”), use one of the handles on the corners of the image.

To control how much of your image is displayed, right-click your image and select Crop. 
This will add black bars around your image. By clicking and dragging those bars, you can 
control the shape of your graphic frame, which dictates how much of your image is dis-
played. For example, in the image below, only half of the image will be displayed because 
the bottom-center bar has been dragged up.

Because the handles are still visible, you can adjust the size of your image within the 
frame while cropping. You can also move your image within the frame while cropping by 
clicking and dragging the image itself.
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Working with layers

Inserting new images

PowerPoint organizes elements on each page using a layer system. This means that you can 
control which images and text appear “on top” of others. In the event that you are trying 
to put, for example, a logo over a larger image, you can use PowerPoint’s Bring to Front 
and Send to Back commands.

Right-clicking any image will present you with those options. Bring to Front and Send to 
Back move the image to either the absolute front or absolute back of the layers on your 
page, and Bring Forward and Send Backward move the image forward or backward one lay-
er at a time.

To add new images to your document, find the Picture button on the Home tab of Power-
Point. Click that button and choose Picture from File. 
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Moving elements from Slide Master to your document

Inserting PDFs

If you find an image on an example page that you’d like to move to a document of your 
own, you can easily copy and paste it. Just find the page with the image you want to copy 
within the Slide Master, right-click the image and select Copy, then return to your page, 
select Edit in the toolbar at the top of the screen, then select Paste. This should put the 
image onto your page in the exact position it was in on the example sheet, and from here 
you can adjust it as you wish.

It is possible to insert PDFs into your PowerPoint template, though you are limited to in-
serting just the first page. For this reason, we encourage you to only insert single-page 
PDFs into your template document.

ON APPLE: select Picture then Picture from File on PowerPoint’s Home tab. This will allow 
you to select a PDF file just as you would any other image file.

ON PC: Click the Insert tab near the top of your PowerPoint window, then select Object, and 
in the resulting window, click “Create From File...” and navigate to your PDF.

Aligning and moving objects
If you need to align one object to another, PowerPoint will automatically “snap” most ob-
jects to another object when their edges or centers are close to one another. Additionally, 
if objects have corresponding edges that are aligned—even if they are on opposite sides of 
the page—PowerPoint will display a line to illustrate their alignment. This is useful if, for 
example, you want the bottom of a text box and the bottom of a photo next to it to be per-
fectly aligned or if you want to make sure that two objects are centered with each other.

COMPOSITION
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Aligning and moving objects, continued
You can also align objects by selecting them and selecting the Shape Format or Picture For-
mat tab (depending on the type of object selected) from the top of your PowerPoint win-
dow. Here, you can select multiple alignment options from the Align button.

Sometimes, when moving objects, the “snap-to” feature might be a hindrance. If you need 
to temporarily disable the “snap-to” feature while moving objects, hold the Option key 
(on Mac) or Alt key (on Windows) to move your object freely.

Finally, the Shift key can be used while moving objects to restrict the direction of its move-
ment. When moving objects, hold Shift while dragging the object to limit its movement to 
a single horizontal, vertical or diagonal axis. This is useful if you want to move something 
directly up, down, left or right.

Ideas for document layout
One of the advantages of these templates is that while you have all the tools necessary to 
create a variety of documents, the composition of your document is up to you—you can 
build whatever you need based off of the materials you have and the info you want to con-
vey. But if you need a few ideas to get started, the next few pages show a few ways you 
might compose your document.
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Ideas for document layout, continued
Six page proposal

Double-sided one pager

Eight page menu of opportunity



12

Ideas for document layout, continued
Four page single fold tabloid sheet (option C of Proposal Toolkit Printing Guide)

Eight page naming opportunity menu


